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Essential Beginner Tips

If you are a beginner to using Photoshop, it can seem like a complicated program 
to understand. This lesson is going to cover the essential tips for getting started.

Collapsing panels

The right side of the interface contains a lot of panels and these panels can some-
times feel like they take up a lot of space. Know that you can double-click on the 
name of a panel to collapse it. This will leave more space for the other panels. 
Double-click on the name again to expand it. 

Far left: The panels 
on the right side 
of the interface are 
expanded. Direct-
ly left: We dou-
ble-clicked on the 
panel names for the 
Color panel and the 
Libraries panel in 
order to collapse 
them, leaving more 
room for the Layers 
panel. 
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Triangle = More stuff

The Toolbar is located on the very 
left side of the interface and contains 
many of the tools you’ll common-
ly use in Photoshop. Looking at the 
icons for each individual tool, you 
might notice that most of them have 
a little arrow in the bottom right cor-
ner of the icon. This arrow means that 
there are more tools hidden behind 
that tool in that same slot. To access 
the other tools, click and hold on the tool’s icon and a menu will pop out, allowing 
you to choose from all of the tools available in that slot. The little arrow visible 
on the tool’s icon is something that you’ll also see in other areas of Photoshop. 
When you see the arrow, it means that there are more options available that are 
not currently visible on your screen. Another example of where you’ll see this is at 
the very bottom of the Layers panel. There are a series of icons and two of them 
have little arrows beneath them. Clicking these arrows will open menus that give 
you several options. The icons that don’t have an arrow will simply do one thing. 

… = Has settings

There are some areas in Photoshop where you will 
see three periods in a row ( an ellipsis) like this: …  
When you see this, it means that there are more op-
tions related to a particular choice. For example, when 
you have a selection tool active, the Options Bar at 
the top of the image window will contain a “Select and Mask…” button. The three 
periods indicate that Photoshop will ask you for more settings when you click that 
button. In the case of the Select and Mask feature, a dialog will appear where you 
will need to work with some masking settings. You will also see options with the 
“…” at the end within the main menu. Whenever you choose one of these options, 
it means that Photoshop will ask you for more settings. 

The little triangles beneath or next to certain 
icons indicate that the tool or function has more 
options. Click and hold on the icon to access a 
menu with all of the available options. 

The “...” means that the fea-
ture has more settings.
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V= Menu here

A tiny down-pointing arrow (that 
looks like a v) means that there is 
a menu. Click on the little arrow to 
get a dropdown menu containing 
settings related to the particular 
feature you’re working with. You 
will see these in many different ar-
eas of Photoshop and often times, 
they are very small and not obvious.

Working with numbers

There are several tasks in Photoshop that will require you to enter in numbers. 
Let’s look at a few little tricks that will help you do this most efficiently. 

When the Brush Tool is active, the Options Bar at the top of 
the screen will contain settings for both Opacity and Flow. 
There are several ways you can change one of these set-
tings. First, you can click on the number to select it, type in 
a new number and hit the Enter key to confirm the setting. 
You can also click on the little down-pointing arrow to ac-
cess a slider that you can drag back and forth to change 
the setting. The next method is my favorite. Click and hold 
on the name of the setting (Opacity, for example) and drag 
left and right to change the numeric setting. This method 
for changing a numeric setting will not only work for the 
Opacity and Flow settings, but for MANY other settings as 
well. You can also click on the number so that it becomes 
highlighted and then use the up and down arrow keys on 
your keyboard to change the number. If you add the Shift 
key, the numeric value will change in increments of 10. 

The v symbol means there is a menu available. 

One way of changing a 
numeric setting like this 
is by clicking on the 
triangle icon and then 
dragging the slider left 
and right. Another way 
is to click and hold on 
the name of the func-
tion and then drag left 
or right. 
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When it comes to features that use numeric settings, you may want to experiment 
with different numbers to see what the result would look like. If you highlight a 
number field, type in a new number and then hit the Enter/Return key, the setting 
will be applied and the text field will no longer be highlighted. If you add the Shift 
key while pressing Enter, the text field will remain highlighted so that it’s easier to 
enter in a different setting. By holding the Shift key, you can quickly experiment 
with different numeric settings without needing to re-highlight the number field. 

Multiple number fields There are some fea-
tures in Photoshop that contain more than 
one number field. For example, the Hue/
Saturation adjustment contains numeric 
fields for Hue, Saturation and Lightness. 
To quickly switch between these different 
fields, hit the Tab key. This applies in any 
feature that contains more than one field 
for you to type something into. 

Change settings with the number keys The number keys on your keyboard have 
the ability to change settings, depending on what tool you’re using. For example, 
if you’re using the Brush Tool, the number keys will change the brush’s Opacity 
setting. Tapping the 5 key will set the opacity to 50%. Typing the 7 key will set the 
opacity to 70%, and so on. If you type two numbers in rapid succession, let’s say 
7 and then 5, you’ll get a precise number (75% in this case). To change the setting 
back to 100, hit the 0 (zero) key. If you add the Shift key (in addition to the number 
keys), you will instead be changing the Flow setting when using the Brush Tool. 

Measurement units Some of Photo-
shop’s Tools make use of a measure-
ment system, and that system can 
change, depending on what settings 
you’re using. The Marquee selection 
tools are examples of this. With the 
Rectangular Marquee Tool active, 
there will be a Style menu available in 

Use the Tab key to switch between  
number fields.

Right-clicking in the text field will present a 
menu for choosing a unit of measurement. 
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the Options Bar. When you click on it, you can choose between making a Normal 
selection (where you drag it out to your desired size manually), a Fixed Size se-
lection or a Fixed Ratio selection. If you choose the Fixed Size option, the Width 
and Height fields will become available. There are several different measurement 
units you can use. In the video example, the Width and Height fields were set to 
pixels (px). Right-click on the number field and a menu will appear, allowing you to 
choose which measurement system you’d like to use. (On a Mac with a one-button 
mouse, holding the Ctrl key while clicking is the equivalent to right-clicking.) 

Some commands in Photoshop make it a little more obvious that you can change 
the measurement system. For example, when changing the image size (Main menu: 
Image > Image Size), there are dropdown menus for the width and height fields 
that provide you with all of the available measurement units. 

Some Photoshop features, like the Image Size settings (shown above), present you with 
dropdown menus for changing the unit of measurement. 



Essential Beginner Tips  © Ben Willmore, All rights reserved 7

Right-click to access contextual menu

If you want to access features that are related to the tool or function you’re using, 
you can often times press your right mouse button to access a contextual menu, 
which is a menu that is specific to whatever tool or function you’re working with. 
For example, if you’re using the Move Tool and you right-click with your mouse, 
you’ll get a menu that is related to layers. If you’re using a Selection Tool and you 
right-click on your image, the menu that appears will contain items all related to 
selections. 

Right-clicking with your mouse will often times present you with a contextual menu, which 
will be different depending on what Photoshop function you’re working with. At left, we 
right-clicked while using the Move Tool and got a menu related to layers. At right, we right-
clicked with an active selection and we got a menu related to selections. 
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Multiple undos

The Undo command will allow you to undo the 
very last thing you did in Photoshop. You can ac-
cess this command by going to the main menu 
and choosing Undo, which is the top item in the 
menu. Alternatively, you can use the keyboard 
shortcut Command+Z (Ctrl+Z on Win). If you use 
this shortcut a second time, it will redo the step 
you just undid. What if you want to go back mul-
tiple steps? You can do this by going to the main 
menu and choosing Edit > Step Backward. This 
will go back one more step in addition to a normal 
undo. Alternatively, you can use the [more con-
venient] keyboard shortcut Option+Command+Z 
(Alt+Ctrl+Z on Win). Using this command, you 
can go back as many steps as you need to. 

When applying the undo commands, you are es-
sentially using your History panel. If the History 
panel is not already visible on your screen, you 
can access it by going to the main menu and 
choosing Window > History. The History panel 
lists everything you’ve done to your document 
since you opened it. You can click on a step to 
take your image back to that stage in the editing 
process. When you use the Step Backward com-
mand, you are essentially moving one step back in 
the History panel. 

The thumbnail at the top of the History panel is a snapshot, and it indicates what 
your image looked like at the time you opened the document. Click on that thumb-
nail at any time to revert your image back to the state it was in when you opened 
the document. 

The History panel shows a list of 
steps you’ve taken in working 
with your document. Click on a 
step to revert the image back to 
that stage. 
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Essential Keyboard Shortcuts

Undo: Undoes the last thing you did in Photoshop

Mac: Command+Z  Win: Ctrl+Z

Step Backward: Go back one more step in addition to a normal undo

Mac: Option+Command+Z  Win: Alt+Ctrl+Z

Zoom In and Zoom Out: Make the view larger or smaller in your image window

Mac: Command++ to zoom in Command+- to zoom out 

Win: Ctrl++ to zoom in Ctrl+- to zoom out

Fit on Screen: Zoom out until you can see your entire picture

Mac: Command+0  Win:  Ctrl+0 

Quickly access the Zoom Tool: Holding down the following keys will temporarily 
access the Zoom Tool. Click and hold on the area of your image that you want to 
zoom in on. 

Mac: Command+Space Bar (hold down as you click and hold on your picture)

Win: Ctrl+Space Bar (hold down as you click and hold on your picture)

Quickly access the Hand Tool: Holding down the Space bar will temporarily ac-
cess the Hand Tool so you can click and drag around your image. When you re-
lease the Space bar, you’ll go back to the tool you were previously using. 

Mac & Win: Space bar (held down)
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Tool Shortcuts: Every tool has 
a keyboard shortcut. Hover 
your cursor over a tool’s icon in 
the Toolbar on the left side of 
the interface and a little tool tip 
will appear, showing you what 
the tool’s shortcut is. 

Bird’s Eye View: When zoomed in on an area of 
your document, you can quickly zoom out to get 
a peek at the image as a whole. When you release 
the shortcut keys, the view will zoom in again.

Mac & Win: Hold down the H key while simulta-
neously holding the mouse button. A box will ap-
pear, indicating the zoom location. You can move 
the mouse (with the button held down) to reposi-
tion the zoom location and, when you release the 
mouse button, it will zoom in to that new location. 

Change Brush Size & Hardness: With the Brush 
Tool active, the following shortcut will give you 
a red overlay that represents your brush tip, 
showing you the size and how soft the edge is. 
Dragging your mouse up/down will change the 
hardness of the brush. Dragging left and right will 
change the size of the brush. 

Mac: Hold down Control+Option and then hold 
the mouse button to drag up/down and left/right.

Win: Hold down Alt and the right mouse button 
to drag up/down and left/right.

Hover over a 
tool icon to see 
a tool tip that 
reveals the key-
board shortcut. 

When in bird’s-eye view, the high-
lighted rectangle will represent 
the area you will zoom in on. 

When using the shortcut to 
change brush size and hardness, 
the red overlay shows a preview 
of the brush. 
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Another way to change the brush size and hardness: On both Mac and Win, you 
can change the brush size by using the square bracket keys ( [ ] ). The left bracket 
will make the brush smaller and the right bracket will make the brush larger. To 
change the brush hardness, use those same left and right bracket keys WHILE 
holding down the Shift key as well. 

Color Picker: With the Brush Tool active, 
the following shortcut will present the Col-
or Picker. Drag up and down on the vertical 
color bar to choose the general color and 
then drag within the color square to deter-
mine how vivid the color should be. 

Mac: Hold down Control+Option+Com-
mand and click and hold the mouse button 
within the image.

Win: Hold down Shift+Alt+Right mouse 
button within the image. 

Reset Colors: Set the foreground and background colors back 
to their default setting, which is black for the foreground and 
white for the background. 

Mac & Win: The D key (This does the same thing as clicking 
the little black and white squares icon above the foreground 
and background swatches in the Toolbar.) 

Swap colors: Swap the current foreground and background colors

Mac & Win: The X key (This does the same thing as clicking the little right-angle 
arrow icon above the foreground and background swatches in the Toolbar.)

The color picker short-
cut allows you to quick-
ly set the foreground 
color. 

The default colors 
are black and white. 
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Full Screen Mode: Gets most of Photoshop’s interface out of the way so that 
you’re only viewing your image. The shortcut will cycle through three different 
view settings.

Mac & Win: The F key 

Hide Extras: This shortcut will hide things like guides, grids and active selections. 

Mac: Command+H   Win: Ctrl+H

Move Tool: Activate the Move Tool

Mac & Win: The V key 


